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Introduction to Salesforce 
 

Quorum utilizes Salesforce as the primary method for communication between customers and our support 

teams. This allows an auditable form of communication for both parties, and is accessible 24/7/365 via the 

online portal. 

 

What is a case? 

A case represents a request submitted to Quorum. It may be a question, a problem, or ask for new 

functionality.    

Requesting Salesforce Access 

If you do not yet have a Quorum Salesforce account, please reach out to your support team lead or super 

user. 

Once the new account has been created, you will receive an email with a URL to follow to finish setting up 

your account. 

Example email (full URL redacted): 
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After following the URL, you will be prompted to set your password. 

 

Logging In 

To access Quorum’s Salesforce customer portal, go to  

https://support.quorumsoftware.com Enter your company  

email address as the Username and the password  

you selected. 

 

Note: If your password has expired, please follow the Forgot Your  

Password? link below the Log In button. If you have any issues  

resetting your password, you may reach out to your support  

representative to report the issue.  

 

 
 

  

https://support.quorumsoftware.com/
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Quick Start to Creating Cases 

 

On the Home Page, there is a quick start prompt for logging a new case.  

Start by typing in a subject that describes the request. 

 

 
 

Next, a prompt appears with the user’s default account prepopulated. If a user is associated to multiple 

accounts under Quorum, they may click on the X to clear out the record and type to search for the other 

account(s). Only accounts the user has been associated to will appear in the list.  
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Moving to the next page, fill in the details about the request.  

 

 
 

1. Record Type: 

a. Enhancement – Request for new functionality that could be a new or updated screen, 

configuration, integration, process, etc.  

b. Issue – Application error, quick functional question, reporting issue, etc. 

2. User submitting the case who will receive updates through Salesforce.  

3. Short description of the issue that will be viewable at a summary level in Salesforce reporting. This 

is populated from the prior screen but can be further updated here.  

4. Cases are routed to the appropriate support teams based on the product selected. It is essential to 

pick the correct product to prevent delays in your case being worked. Note: If the Product list does 

not contain a value the user expects, they should select the Quorum product that is most closely 

related to the issue being reported for these tools. Some related tools will be found as categories 

under a product. If no product is available, reach out to support using the  

escalation path.  

5. Indicates the impact and severity of the issue. See Case Priority Definitions for more information.  

6. Indicates whether the submitted case is related to project activities rather than production support.  

7. Detailed explanation of the issue. See Case Logging Best Practices for tips on the type of 
information to provide. 
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Once the required fields have been filled out, click on the Next button which contains additional prompts. 

 

 

On this screen, the user has a text view of the information submitted on the prior page and additional 

prompts.  

 

1. Populate this field with the version of software related to the request. Provide as much detail as 
available, such as the specific build version. Note: For On Demand Suite, this may be left blank. 

2. This droplist is populated based on the Product selected and is used to indicate the area of the 
application related to the case being submitted. 

3. This indicates the environment where the issue originated (i.e. production or test environment). 

4. While this field is optional, providing clear steps to replicate the issue ensures Quorum has the 
information needed for validating the reported issue.  

5. Toggling this button will add an additional prompt on the next page where attachments can be 
immediately added to the case.  

 

By clicking Next, the case will be submitted.  
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If the user has selected to add attachments, the case will still be submitted immediately but the user will be 

taken to a new page to add the attachments. 

  

 
 

Once the case has been submitted, the user will be taken to view the new case. Note that a case number 

is assigned upon creation, which is a unique identifier for the case.  
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Case Logging Best Practices 

When logging Quorum support issues, including the following information will assist the Customer Support 

team to work towards resolution: 

 Accurate priority 

 Environment where issue is present 

 # of affected users and impacted deadlines 

 Screenshots of observed behavior and related screen/process name 

 Steps outlining how to reproduce the reported behavior 

 Data examples (inputs, outputs, notable attributes) 

 Any updates or environment changes made prior to reported behavior 

 Current vs. expected results 

 

Case Priority Definitions 

Critical – An emergency condition that causes the system to fail or causes customer data to be lost or 

destroyed. A showstopper usability bug can also be one that is likely to cause frequent data integrity 

errors. There is no workaround to these problems.  

Example: Billing process fails with non-descriptive or technical error message 

 

High – A serious condition that impairs the operation, or continued operation, of one or more product 

functions and cannot be easily circumvented or avoided. The software does not prevent the user from 

making a serious mistake. The usability problem is frequent, persistent, and affects many users. The 

application is moderately impacted and there is not workaround currently available, or the workaround  

is cumbersome to use. 

 

Example: Screen validation prevents record save for non-business critical function 

 

 

Medium – A non-critical, limited problem. It does not hinder operations and can be temporarily 

circumvented or avoided using an acceptable workaround. The problem causes users moderation 

confusion or irritation. 

 

Example: Unexpected warning message appears on screen, but data saves successfully 

 

 

Low – Non-critical problem, general questions about the product or the functionality does not match 

documented specifications. These could be misspellings or change or wording in existing documentation. 

There are minor inconsistencies that cause hesitation or small cosmetic issues like labels and fields that 

are not aligned properly. 
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Communicating through Cases 

Posting in Salesforce 

The Post section of the Case screen gives a timeline ordering of messages and updates to the case. You 

may change the sort order to have the most recent activity or latest posts on top.  

 

 
 

Please note if a comment is posted in direct reply to a specific post that comment will appear beneath the 

original post.  
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To make a new post, click on Share an update to start typing. 

 

 
 

Now you can begin typing your message. You may also use the paperclip icon at the bottom left to  

attach pictures or documents. One you are finished, use the Share button to submit.  

 

 
 

To comment directly on a specific post, click on Write a comment under the post.  
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The best practice is to make new posts when asking for information or updates on a case rather  

than replying to an existing post.  
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Salesforce Email Communications  

Case Comments 

When a Quorum employee posts on a case, the customer contact on the case receives an email alerting 

them that a comment has been made.  

Here is a sample email of a customer support representative replying to a customer through a post on  

the case. 

 
 

Do not reply to the email. Instead, click on the URL which will take the user to the Salesforce case to 

reply directly.  

Communicating Via Case Emails 

At times the Quorum support team may also send communication via an email generated through the 

Salesforce case. These emails will come from a @quorumsoftware.com email address which is associated 

to that product support team. Each product support queue has their own unique email address which is 

used by Salesforce.  

Here is an example email sent from a case. Even though it says the case is from the generic eOne email 

address, if the user replies to this email, the support representative assigned to the case will receive a 

notification that a new message has been received. This ensures even if the support representative 

working a specific case change, the reply reaches the appropriate person.  
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When communicating with Quorum via an email chain associated to a case, there are a few rules to keep 

in mind 

 The email address that originally sent the email from Salesforce must remain in the addresses 
receiving any further replies in the email chain. Removing it breaks the link with the case. 

 Do not forward the email as this breaks the link to the case. 

 Pictures may be included, but attachments are recommended to still be uploaded directly to the case, 
so they display under the Files tab in Salesforce. 

Users may CC additional email addresses when replying to an email from Salesforce; and replies from 

those email addresses, so long as they also keep the above rules in mind, will also appear on the case 

and receive future replies from Quorum to that email chain.  

Creating a Case Via Email 

If users send a new email to the product support team’s Salesforce email address, this will generate a new 

case that is sent to the team’s queue. However, these cases will be created with minimal details (subject, 

body of the email as the details, case contact), as opposed to the Salesforce portal which allows users to 

choose whether a case is related to a project, is an issue or enhancement, and set a priority for the case 

(emails by default create cases as a medium priority).  

Once you send an email to the specific product support team’s Salesforce email address, you will receive 

a confirmation email from a do not reply email address with the case number. Creating a case via the 

portal will generate the same email.  
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Once a support team member is assigned to your case, they will send an email via Salesforce that starts 

an email chain you may reply to which automatically updates the case in Salesforce. Note: this email is 

tied to a specific case. If you wish to start a new request, you should create a brand-new email which will 

generate a new case.  
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Viewing and Adding Attachments 

When viewing a case, users may attach additional files by going to the File tab.  

 

 

 

Clicking on Add Files brings up a popup window to upload new files.  
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Once the file is finished uploading, click Done to return to the File tab. 

 

 
 

The file is now viewable by both the user and Quorum. Attachments added by Quorum will also appear  

in this list.  
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Additional Topics 

How to Escalate a Case 

If there are any concerns that come up for a case, Quorum has implemented an escalation process to 

follow. Each product support team has its own escalation path.  

Escalation Path 

Case Owner  →  Support Team Manager  →  Practice Area Lead 

The latest copy of the escalation path contact information can be found on the Salesforce homepage after 

logging into the site. 

 

 

Escalation Process 
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Case List Views 

From the menu at the top of the screen, click on Cases. 

 

On the default view, cases the user has recently viewed will appear.  

 
 
Clicking on the droplist allows the user to pick from several different views. 
 

 
 

To open a case from the Cases listing, click on either the Case Number or the Subject. 

 

 



 

 

 

 

Confidential 

11-2-2022 

 

 

20/39 
 

 

© 2022 Quorum Software. All Rights Reserved. 

Reporting 

The reporting section allows users to create their own reports and view reports published by Quorum.  

Please note that when looking at the reports listed, users will see all customer reports created and 

published – however if a user selects a report that belongs to another customer, they will not see cases for 

other customers. Cases are restricted based on the account(s) an individual’s user ID is associated to in 

Salesforce which is controlled by Quorum. 

 

How to Run Reports 

Step 1: 

From the menu at the top of the screen, click on Reports in the upper right. 

 
 

Step 2:  

On the left side of the Report screen, click on Shared with Me.  
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Step 3: 

Next, click on the “Support Reports” folder. 

 
 

Step 4:  

Click on “Name” to sort by name and scroll down to search for a report 

 
Please note that when looking at the reports listed, you will see all customer reports created and published – however if you select a 

report that belongs to another customer, the report will be blank when you select it, because it is not your report configured to your 

account. Any visible data will be your own with that report’s formatting and filtering applied.  

 
 

Step 5:  

Quorum has also created a standard report that allows users to review all of their open support cases, 

including cases submitted by other users for their company.  

Scroll down to the report “Open Support Cases Report – For External” and click on its name. 
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This report displays all open cases—restricted based on the accounts your user ID is associated to in 

Salesforce. The Last Comment column in the report can be used to see the latest post on the case by 

either the customer or Quorum.  

 

 

 

 
 

Step 6: 

When viewing a report, you may also export it to Excel.  

At the top right of the report, there is an arrow that gives a drop list menu. Select Export.  
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Reports can either be exported with full formatting (1) or only the raw data (2). This will allow the user to 

send complex reports with groups and sorting from Salesforce or build out pivots and filter down records 

for further analysis.   
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How to Create New Reports Using Existing Reports 

While Quorum has published basic reports, users may prefer to build a custom report with additional 

columns or filters to better analyze their Salesforce case data.   

A quick way to create a new report is from copying an existing one.  

 

Step 1: 

When viewing a report you want to copy, click on the arrow next to the Edit button and then click  

“Save As”.  

 

 
 
 

This will bring up a popup window.  
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Step 2: 

Click on the “Select Folder” button to choose where to save the report.  

 

 
 

 

If you do not want any other users have this report available, you may select “Private Reports”. Otherwise, 

reports should be saved in the “Support Reports” folder under “All Folders”.  
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Step 3: 

Clear out the “Report Unique Name” field and leave it blank. This field will auto populate after the “Report 

Name” field is updated.  

Rename the report to be a name that will be identifiable in the shared list of reports. Generally, a 

report name including your company’s name is recommended for reports that will not be saved in the 

Private folder.  

 

 
 

The copied report will display after clicking the Save button. 
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Step 4: 

When viewing the report, use the Edit button to open the Report Builder screen.  

 

 
 

Step 5: 

On the Report Builder screen, the Outline tab will start with all the fields from the report that was copied. 

Click on the X by any column to remove it.  
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To add an additional column, start typing in the Add Column field and click on the desired result. 
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The columns can be reordered by clicking on an entry and dragging and dropping it in a new location.  
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The Add Group field can be used in the same way to create grouping in the report. Once a single group 

has been added, the user will have the option to also add a column grouping to create a chart. Fields may 

also be moved from the Columns section to the Groups section.  

Note that only fields not already in the report as a column can be selected under “Add Group”.  
 

 
 

When there is both a group by row and a group by column, Salesforce will display a table for the user. By 

default, the details will display for all cases below the table.  
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The user may click on any box within the table to narrow down the details results to only that information. 

See in the image below that it shows the details will only display two records, which matches the box 

selected in the report table.  

 

 
 

Step 5: 

The Filters tab works similarly to the Outline tab.  

First the user would type in the “Add filter” box to select a field.  
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Once a filter field is added, it prompts the user to choose the filter restrictions.  

Using the Equals operator does allow the user to select multiple values.  
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After clicking Apply, the user will see the filter added with its criteria listed in the left panel.  

 

 
 

Other filter operators may require the user to type the criteria to use. 
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To edit any existing filters, click into the field and it will pop up options to select filter criteria. 
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Step 6: 

After finishing adding report columns and filters, the next step is to either run the report to see it with all 

records or to save it.  

 

1. This option will run the report without saving any changes. If this option is used, make sure to click  
Edit when viewing the report to come back to the Report Builder screen to save it. 

2. This option saves the report and keeps the Report Builder screen open to continue making changes.  

3. This option saves the report and immediately runs it to view. 
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Email Notifications 

Salesforce allows users to control which types of actions generate email notifications. If you would like to 

update these settings, click on the silhouette of a person at the top right of the page. Click on My Settings 

from the menu drop down.  

 

Go to the Email Notification section to select which actions generate an email notification.  
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Quorum Support Dashboard 

The Quorum Support Dashboard available via the home screen or through the Dashboard menu displays 

the support metrics for cases visible to the user based on their account user permissions. Users who can 

only see cases they submitted will only see metrics applicable to those cases. 

 

 

 

If the as of date for the dashboard does not reflect the current time, the user may click the Refresh button 

to bring back the latest results.  
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To see the results behind any of the dashboard widgets, click the View Report link at the bottom of  

the widget. 

 

 
 

This takes the user to the report behind the widget where the specific cases and the relevant information is 

displayed. Use the back button in the browser to return to the dashboard from here. 
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About Quorum 

 

Quorum Software is the largest fully-dedicated energy industry software provider in 
the world, serving more than 1,800 customers across the entire energy value chain in 
55 countries. Quorum’s solutions power growth and profitability for energy businesses 
by connecting people, workflows, and systems with decision-ready data. Twenty years 
ago, we delivered the industry’s first software for gas plant accountants, and today our 
solutions streamline business operations with industry forward data standards and 
integrations. The global energy industry trusts Quorum’s experts and applications to 
successfully navigate the energy transition while delivering value today and into the 
future. For more information, visit quorumsoftware.com. 


